Welcome to Corel WinDVD

Thank you for purchasing Corel WinDVD, the DVD and video playback software that offers the most lifelike cinematic experience on your computer. Now you can enjoy the latest blockbuster movies with superior audio and video quality from the comfort of your home. Corel WinDVD has an easy-to-use design that lets you play standard and high-definition video. It provides support for the new Blu-ray 3D technologies, playback of DVD and AVCHD video, and combines all the features of a standard consumer player with some advanced options.

This section contains the following topics:

• What’s new in Corel WinDVD 11
• System requirements
• Installing and uninstalling Corel WinDVD
• Starting and quitting Corel WinDVD
• Getting Corel updates
• Viewing product information
• Registering Corel products
• Corel Support Services
• About Corel

The availability of features described in the documentation depends on the version of the software you have. Visit www.corel.com for more information.

Was this page helpful? Send feedback.
(Internet connection required.)
Welcome to Corel WinDVD

What’s new in Corel WinDVD 11

New design
Corel WinDVD 11 introduces a redesigned application window with quick and responsive playback controls that provide effortless navigation of discs and other media and easy access to all the main features.

Blu-ray 3D disc playback
Corel WinDVD offers the best Blu-ray and HD video playback performance on your PC. With the introduction of new Blu-ray 3D technologies, you can experience high-definition Blu-ray movies in an enthralling 3D environment. It accommodates side-by-side playback, and lets you watch streaming 3D video files or videos recorded on Fujifilm 3D camera and other 3D camcorders. It also supports playback of large-capacity BDXL discs, the latest Blu-ray format, which allows users to create 100 GB rewriteable discs.

2D to 3D conversion
Convert your 2D video to 3D on the fly. This technology analyzes the color, position and motion characteristics in 2D video to render stereoscopic 3D views during video playback.

HD video playback
Corel WinDVD 11 plays high-definition Blu-ray and other HD movies with stunning 1080p sharpness and next-generation surround sound on your PC. It also supports the playback of BDXL files and HD video from DVD recordable discs with AVCREC and AVCHD support.

Playback directly from camera or camcorder
Preview videos on your PC directly from your camera, camcorder or storage device for an instant playback of the event you captured.

Broad video format support
Corel WinDVD 11 supports a wide range of video formats from the most common video types, including DVD-Video, QuickTime, Windows Media (WMV), Blu-ray to new file formats such as, DivX, MKV, MTS, M2TS, MP4, 3GP and FLV, and plays back from memory cards or internal camera memory.

Premium video search
Corel WinDVD 11 includes FlixFinder, an integrated online movie search engine that lets you find and play premium streaming or downloaded movies and TV shows from partners such as Amazon, Hulu, and Netflix. Tag and search videos by various criteria, compare prices and compile a list of Favorites.

Video stabilizer
The video stabilization filter stabilizes excess camera motion in hand-held home videos for a more pleasant viewing experience.

Motion streamliner
Increase the frame rate and interpolate frames to remove the jitters from fast motion, making it appear much smoother.
Video Enhancements
Fine-tune your video with a variety of controls such as increased contrast and saturation for a more cinematic look. Corel WinDVD employs the best upscaling technology available to turn a variety of standard-definition formats into a stunning high-definition experience.
Welcome to Corel WinDVD

**System requirements**

Corel WinDVD 11 supports the Windows 7, Windows XP SP3, and Windows Vista SP1/SP2 operating systems.

Before you install Corel WinDVD on your PC, make sure that your system meets the minimum hardware and software requirements.

### Playback of DVD disc

<table>
<thead>
<tr>
<th>Minimum system requirements</th>
<th>Recommended system requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating system</strong></td>
<td></td>
</tr>
<tr>
<td>Windows 7, Windows Vista (Service Pack 1) or Windows XP (Service Pack 3)</td>
<td>Windows 7, Windows Vista (Service Pack 1) or Windows XP (Service Pack 3)</td>
</tr>
<tr>
<td>Windows XP: Intel Pentium III 800 MHz or equivalent AMD Athlon processor</td>
<td>Windows 7: Intel Core Processor Family, AMD Athlon 64 X2 3800+ 2.0 GHz or higher</td>
</tr>
<tr>
<td><strong>Processor</strong></td>
<td></td>
</tr>
<tr>
<td>Windows Vista: Intel Pentium 4 2.8GHz or equivalent AMD Athlon processor, or higher</td>
<td>AGP or PCI Express graphic accelerator card with DirectDraw Overlay support for VRAM 64 MB or above</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td></td>
</tr>
<tr>
<td>256 MB RAM</td>
<td>512 MB or higher RAM</td>
</tr>
<tr>
<td><strong>Graphics card</strong></td>
<td></td>
</tr>
<tr>
<td>AGP or PCI Express graphic accelerator card with DirectDraw Overlay support</td>
<td>AGP or PCI Express graphic accelerator card with HWMC, DirectDraw Overlay support for VRAM 64 MB or above</td>
</tr>
<tr>
<td><strong>Audio card</strong></td>
<td></td>
</tr>
<tr>
<td>PCI sound card or on-board audio</td>
<td></td>
</tr>
<tr>
<td><strong>Free hard disk space</strong></td>
<td></td>
</tr>
<tr>
<td>250 MB</td>
<td></td>
</tr>
<tr>
<td><strong>Optical drive</strong></td>
<td></td>
</tr>
<tr>
<td>DVD-ROM, DVD-ROM/CD RW combo, DVD-R/RW, DVD+RW, or DVD-RAM drive</td>
<td></td>
</tr>
</tbody>
</table>

### Playback of Blu-ray and HD files

<table>
<thead>
<tr>
<th>Minimum system requirements</th>
<th>Recommended system requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating system</strong></td>
<td></td>
</tr>
<tr>
<td>Windows 7, Windows Vista (Service Pack 1) or Windows XP (Service Pack 3)</td>
<td>Windows 7, Windows Vista (Service Pack 1) or Windows XP (Service Pack 3)</td>
</tr>
<tr>
<td><strong>Processor</strong></td>
<td></td>
</tr>
<tr>
<td>Intel Core Processor Family,</td>
<td>Intel Core</td>
</tr>
</tbody>
</table>
### Minimum system requirements

<table>
<thead>
<tr>
<th>Category</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows 7</td>
</tr>
<tr>
<td>Processor</td>
<td>Intel Core II Duo T2400 1.83 GHz, AMD Athlon 64 X2 3800+ 2.0 GHz or higher</td>
</tr>
<tr>
<td>Memory</td>
<td>1 GB RAM or higher RAM</td>
</tr>
<tr>
<td>Graphics card</td>
<td>NVIDIA GeForce 500/400/300/200 or newer.</td>
</tr>
<tr>
<td>Audio card</td>
<td>Windows-compatible sound card</td>
</tr>
<tr>
<td>Free hard disk space</td>
<td>250 MB</td>
</tr>
<tr>
<td>Optical drive</td>
<td>Windows-compatible BD drive for BD playback</td>
</tr>
</tbody>
</table>

### Recommended system requirements

<table>
<thead>
<tr>
<th>Category</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows 7</td>
</tr>
<tr>
<td>Processor</td>
<td>Intel Core II Duo T2400 1.83 GHz, AMD Athlon 64 X2 3800+ 2.0 GHz or higher</td>
</tr>
<tr>
<td>Memory</td>
<td>1 GB RAM or higher RAM</td>
</tr>
<tr>
<td>Graphics card</td>
<td>NVIDIA GeForce 500/400/300/200 or newer. AMD Radeon HD 6000 series or newer.</td>
</tr>
<tr>
<td>Audio card</td>
<td>Windows-compatible sound card</td>
</tr>
<tr>
<td>Free hard disk space</td>
<td>250 MB</td>
</tr>
<tr>
<td>Optical drive</td>
<td>Windows-compatible BD drive for BD playback</td>
</tr>
<tr>
<td>3D Display</td>
<td>Using Anaglyph/Polarization/Checkerboard type for Blu-ray 3D playback</td>
</tr>
<tr>
<td></td>
<td>Using HDMI 1.4 compatible</td>
</tr>
</tbody>
</table>
panel for 3D playback

- HDMI1.4 compatible TV/Monitor

Using NVIDIA 3D Vision to

- 3D playback (frame sequential display)

- 120Hz supported display panel through DVI-D link

NVIDIA 3D Vision Shutter Glasses or XpanD Polarized

- 3D glasses

VGA card: NVIDIA GeForce

500/400/300/200/100/9series/8800 + latest VGA driver

Through eDP (internal LCD, frame sequential display):

- Intel H5x series + latest VGA drivers

**Requirements for Blu-ray 3D playback**

Check the system requirements of the operating system that you are using to maximize the compatibility and performance of Corel WinDVD.

Was this page helpful? Send feedback.

(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Installing and uninstalling Corel WinDVD

The Installer makes it easy to install Corel applications and components. It lets you:

• install and uninstall any Corel applications included in your software package
• add components to a currently installed application
• refresh files and configuration of currently installed applications

To install Corel WinDVD

1. Close all running programs.
2. Insert the Corel WinDVD installation disc in the DVD drive. The **Setup** window appears followed by the **Welcome to WinDVD Setup** window.
3. If the installation wizard does not start automatically, double-click the **My Computer** icon on your desktop, browse to the DVD drive where you inserted the Corel WinDVD installation disc, and double-click the **Setup** icon.

To uninstall Corel WinDVD

1. On the Windows taskbar, click **Start**, and click **Control Panel**.
2. In the **Control Panel** window, double-click the **Add or Remove Programs** icon.
3. In the **Add or Remove Programs** dialog box, click **Corel WinDVD 11** and click **Change/Remove**.
4. Click **OK** to confirm.
5. Follow the instructions to uninstall the application.

Was this page helpful? Send feedback.

(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Welcome to Corel WinDVD

Starting and quitting Corel WinDVD
You can start Corel WinDVD from the Windows desktop or Start menu and quit the program from the application window.

To start Corel WinDVD

Do one of the following:

- On the desktop, double-click the Corel WinDVD 11 shortcut.
- In the Windows Start Menu, click Corel WinDVD 11 from the list of installed programs.

The shortcut is available only if you have added it during installation.

To quit Corel WinDVD

On the application window, click the Close button.

Was this page helpful? Send feedback.
(Internet connection required.)
Welcome to Corel WinDVD

: Getting Corel updates

Quick links to procedures on this page:
• To get product updates

Getting Corel updates
Corel WinDVD lets you access the latest product software updates and enhancements and prompts you when new updates are available.

To get product updates
1. On the upper right corner of the application window, click the Corel Guide button .
   Click the Product information and preferences button and click Check for Updates.
2. You must connect to the Internet to use this feature.

Was this page helpful? Send feedback.
(Internet connection required.)
Welcome to Corel WinDVD
: Viewing product information

Quick links to procedures on this page:

• To view product information

Viewing product information
You can browse for information about the latest Corel products and help resources.

To view product information

1. On the upper right corner of the application
   window, click the Corel Guide button .
   Click the Product information and preferences
   button and click About.

Was this page helpful? Send feedback.
(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Welcome to Corel WinDVD

Getting help

The Corel Guide offers a variety of video tutorials to help you familiarize yourself with the various functions of Corel WinDVD.

To get help

1. On the upper right corner of the application window, click the Corel Guide button. Click the Home tab to view a selection of useful tutorials.

2. Was this page helpful? Send feedback. (Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Registering Corel products
Registering Corel products is important to ensure that you receive timely access to the latest product updates, as well as valuable information about product releases. Registration also gives you access to free downloads, articles, tips and tricks, and special offers.
For more information about registering a Corel product, visit www.corel.com/support/register.
Corel Support Services

Corel Support Services can provide you with prompt and accurate information about product features, specifications, pricing, availability, services, and technical support. For the most current information on available support and professional services for your Corel product, please visit www.corel.com/support.

For additional information on Corel WinDVD, check the Knowledgebase articles at the Corel Web site.

Was this page helpful? Send feedback.
(Internet connection required.)
About Corel

Corel is one of the world's top software companies, with more than 100 million active users in over 75 countries. We develop software that helps people express their ideas and share their stories in more exciting, creative, and persuasive ways. Through the years, we've built a reputation for delivering innovative, trusted products that are easy to learn and use, helping people achieve new levels of productivity. The industry has responded with hundreds of awards for software innovation, design, and value.

Our award-winning product portfolio includes some of the world's most widely recognized and popular software brands, including CorelDRAW Graphics Suite, Corel DESIGNER Technical Suite, Corel Digital Studio, Corel Painter, Corel PaintShop Photo Pro, Corel VideoStudio, Corel WinDVD, Corel WordPerfect Office, and WinZip. Our global headquarters are in Ottawa, Canada, and our major offices are in the United States, the United Kingdom, Germany, China, Taiwan, and Japan.
Exploring the workspace

This chapter provides an overview of the playback-related commands and controls of Corel WinDVD 11. These commands are accessible through the Control bar, Caption bar and the right-click menu. The image below shows the main components of the Corel WinDVD 11 application window:

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Caption bar</td>
<td>lets you access customization options</td>
</tr>
<tr>
<td>(2) Viewing area</td>
<td>lets you view videos</td>
</tr>
<tr>
<td>(3) Control bar</td>
<td>provides access to playback controls</td>
</tr>
</tbody>
</table>

This section contains the following topics:

- Control bar
- Caption bar
- Right-click menu

Was this page helpful? Send feedback.

Copyright 2011 Corel Corporation. All rights reserved.
**Exploring the workspace**

: Control bar

## Control bar
The Control bar provides access to commands that let you control the playback of media files. It appears when you hover over it and hides when you move the cursor away from it. This auto-hide feature gives you more screen space for watching movies, even in 3D mode.

![Control bar](image.png)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Audio Tech Logo" /></td>
<td><strong>Audio Tech Logo</strong> Indicates the currently-used audio technology such as PCM, PCM 96/24, LPCM, Dolby Digital, Dolby Digital Plus, Dolby TruHD, DTS, or DTS-HD</td>
</tr>
<tr>
<td><img src="image.png" alt="Volume Bar" /></td>
<td><strong>Volume Bar</strong> Drag the slider to the left or right to decrease or increase the playback volume, respectively. Click the speaker icon to mute the volume.</td>
</tr>
<tr>
<td><img src="image.png" alt="Stop" /></td>
<td><strong>Stop</strong> Lets you stop media playback</td>
</tr>
<tr>
<td><img src="image.png" alt="Rewind" /></td>
<td><strong>Rewind</strong> Lets you rewind a movie. By default, the reverse speed is 1x; however, you can change it to one of the following speed options: 2x, 4x, 8x, 20x or 60x by clicking repeatedly.</td>
</tr>
<tr>
<td><img src="image.png" alt="Previous" /></td>
<td><strong>Previous</strong> Lets you return to the previous chapter</td>
</tr>
<tr>
<td><img src="image.png" alt="Play/Pause" /></td>
<td><strong>Play/Pause</strong> Lets you start or pause video playback.</td>
</tr>
<tr>
<td><img src="image.png" alt="Next" /></td>
<td><strong>Next</strong> Lets you jump to the start of the next chapter</td>
</tr>
<tr>
<td><img src="image.png" alt="Forward" /></td>
<td><strong>Forward</strong> Lets you fast forward a movie. By default, the forward speed is 2x; however, you can change it to one of the following speed options: 4x, 8x, 20x or 60x by clicking repeatedly.</td>
</tr>
<tr>
<td><img src="image.png" alt="Full Screen" /></td>
<td><strong>Full Screen</strong> Display the application window in full-screen mode.</td>
</tr>
</tbody>
</table>
full-screen mode
reset the application window to its previous size

Displays the number of hours:minutes:seconds a movie has been playing

Displays the duration of the movie in hours:minutes:seconds

Lets you open files from different sources
Displays additional options such as

Bookmark ? opens the bookmark browser window
Capture ? opens the capture browser window

Enhancements ? displays different audio and video enhancement options

Lets you open the submenu to display additional options such as

Root Menu
Title Menu
Chapters
Subtitles
Audio

Lets you enable 3D mode. Click the triangle next to the icon to customize 3D settings

Ejects the optical disc from the player

When the disc or file that you are playing does not include the features mentioned in the preceding
table, the control buttons are grayed.

Was this page helpful? Send feedback.
(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Right-click menu
The right-click menu in Corel WinDVD 11 provides a list of options to control the audio or video playback. The menu can be accessed by right-clicking in the Viewing area. Some of the options are grayed out if the media that you are playing does not support the features in the list. The arrows next to the menu items indicate that there are additional options. Hover over an arrow to access the additional options.

Right-click Menu

Was this page helpful? Send feedback.
(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
## Caption bar

The table below outlines the controls available on the Caption bar.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="Product Logo" /></td>
<td>Product Logo</td>
<td>Indicates the version of the current media player</td>
</tr>
<tr>
<td><img src="#" alt="FlixFinder" /></td>
<td>FlixFinder</td>
<td>Opens the Corel FlixFinder Web site</td>
</tr>
<tr>
<td><img src="#" alt="Search" /></td>
<td>Search</td>
<td>To initiate a search, enter a word in the search box and press Enter</td>
</tr>
<tr>
<td><img src="#" alt="Preferences" /></td>
<td>Preferences</td>
<td>Lets you customize viewing preferences</td>
</tr>
<tr>
<td><img src="#" alt="Corel Guide" /></td>
<td>Corel Guide</td>
<td>Displays the Corel Guide, providing access to various help resources</td>
</tr>
<tr>
<td><img src="#" alt="Minimize" /></td>
<td>Minimize</td>
<td>Hides the window but keeps the application running and quickly accessible on the taskbar</td>
</tr>
<tr>
<td><img src="#" alt="Maximize/Restore" /></td>
<td>Maximize/Restore</td>
<td>Displays the window in full screen mode / Resets the window to its previous size</td>
</tr>
<tr>
<td><img src="#" alt="Close" /></td>
<td>Close</td>
<td>Quits the Corel WinDVD 11 player</td>
</tr>
</tbody>
</table>

> Was this page helpful? Send feedback.

(Internet connection required.)
Getting started

In this section, you can find information about the commonly performed tasks. This section contains the following topics:

• Playing media
• Viewing movies
• Zooming and stretching
• Adjusting volume
• Adjusting picture quality
• Rewinding and forwarding
• Changing chapters
• Ejecting and reloading discs

Was this page helpful? Send feedback.
(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Getting started

: Playing media

Quick links to procedures on this page:

• To play media files
• To pause playback

Playing media
Corel WinDVD starts automatically when you insert a movie disc in your default optical drive.

To play media files
1. On the Control bar, click Open to display the open menu.

2. Choose one of the following options:
   • File ? lets you open a media file on your hard drive
   • Disc Folders ? lets you play video from a AVCHD folder saved on a SD, MS, Hard Drive or Disc, play DVD video from a DVD folder saved on the hard drive, and play a BDMV folder authored by Corel Movie Writer.
   • Playlist ? lets you open a media file from a saved playlist
   • Disc ? lets you open a media file from a disc

You can also press [Ctrl] + [O] to open media files from different sources.

To pause playback
1. On the Control bar, click Pause.

2. Press the spacebar on the keyboard to pause or resume playback.

Was this page helpful? Send feedback.
(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Getting started
: Viewing movies

Quick links to procedures on this page:

- To resize the application window
- To choose a full-screen preview mode

Viewing movies
You can customize the application window size and viewing mode in Corel WinDVD.

To resize the application window
Point to the edge of the application window and drag until the application window is the size you want.

To choose a full-screen preview mode
- Double-click the viewing area or press [F].
  - To restore the application window to its previous size, double-click anywhere in the application window or press [Esc].
  - In full screen mode, clicking the viewing area once displays the Caption bar and Control bar.
  - To choose full-screen mode as your default viewing mode, in the Corel WinDVD Preferences dialog box, enable Start from full screen mode.

Was this page helpful? Send feedback.
(Internet connection required.)
Getting started

: Zooming and stretching

Quick links to procedures on this page:

• To zoom
  To enable Smart Stretch

Zooming and stretching

You can get a closer look at your favorite scenes by experimenting with a variety of zoom options to determine the amount of detail you want. You can also crop and stretch slightly the sides of a video while keeping the center undistorted.

For more information about smart stretching, see "Adjusting aspect ratio."

Both features are ideal for optimizing DVD playback for a widescreen display.

To zoom

1. Right-click in the viewing area, and click Zoom In/Out.
2. Choose the option you want.

• You can also zoom in by pressing [+] or zoom out by pressing [-].

To enable Smart Stretch

1. On the Control bar, click Tools > Enhancements.
2. Click the Video tab, click Ratio and click the Smart Stretch option.

Was this page helpful? Send feedback.
(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Getting started
: Adjusting volume

Quick links to procedures on this page:

• To increase the volume
• To decrease the volume
• To mute the volume

Adjusting volume
Once a movie has started, you can adjust its volume.

To increase the volume

• Drag the volume slider to the right or press [Shift]+[Up]/Wheel Up on the keyboard.

To decrease the volume

• Drag the volume slider to the left or press [Shift]+[Down]/Wheel Down on the keyboard.

To mute the volume

• Click the Mute button or press [M] on the keyboard.

Was this page helpful? Send feedback.
(Internet connection required.)
Getting started
: Adjusting picture quality

Quick links to procedures on this page:
* To adjust the picture quality

Adjusting picture quality
You can adjust the picture quality of a video during playback by changing the overall color scheme of the video content.

To adjust the picture quality
1. On the Control bar, click Tools > Enhancements.
2. Use the color controls in the Video Color menu to fine-tune the display. The functions of these controls are similar to the controls found on a standard television set.
3. Use the sliders to set the Brightness, Contrast, Hue, Saturation, and Gamma. For more information, see "Adjusting video color."

Was this page helpful? Send feedback.
(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Rewinding and forwarding
You can rewind a movie to go back to a previous scene and fast-forward a movie to skip to the next scene at incremental speeds.

To rewind a movie
- Click the Rewind button or press the [Left Arrow] key on the keyboard.

To fast-forward a movie
- Click the Fast Forward button or press the [Right Arrow] key on the keyboard.
  - The playback speed increases as you click the button.
  - When the fast-forward speed is set to 2x, you can still understand the dialogue.
Quick links to procedures on this page:

- To jump to a different chapter

## Changing chapters
You can skip an entire chapter in a movie and go to the next chapter or go back to a previous chapter during playback.

### To jump to a different chapter
- Click the Next or Previous Chapter button.
- You can also do the following:
  - Press [Page Up] on your keyboard to go to the previous chapter.
  - Press [Page Down] on your keyboard to go to the next chapter.
  - Right-click in the viewing area to display the Chapter menu.

Was this page helpful? Send feedback.

(Internet connection required.)
Ejecting and reloading discs
Use the Corel WinDVD player to eject a disc from the optical drive.

To eject and reload a disc
• Click the Eject button, or press [Ctrl] + [E] on the keyboard.

Was this page helpful? Send feedback.
(Internet connection required.)
Exploring additional features
There's more to viewing a DVD or a Blu-ray title than simply running a movie from beginning to end. Corel WinDVD lets you expand your viewing experience by providing other features. This section contains the following topics:

- Setting preferences
- Using LanguageMate
- Viewing on-screen display
- Using Corel FlixFinder

Was this page helpful? Send feedback.
(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Setting preferences
You can customize your audio and video preferences to meet your specific playback requirements.

To change basic audio and video settings
• On the Control bar, click Tools > Enhancements.

To change advanced audio and video settings
• Do one of the following:
  • Right-click in the viewing area and click Preferences.
  • Click the Preferences button on the Caption Bar.
  • Press [Ctrl]+[,] to open Preferences.

For more information about customizing settings, see "Configuring Corel WinDVD."
Using LanguageMate

LanguageMate lets you repeat a segment at either 6, 12 or 18 second intervals. This feature can be used to learn a new language by continuously repeating the same segment and listening and practicing to speak in the new language.

To enable LanguageMate

1. Right-click in the viewing area, click Repeat/Shuffle, and then click LanguageMate.
2. Choose the desired looping time:
   - Repeat 6" to repeat a segment at 6-second intervals
   - Repeat 12" to repeat a segment at 12-second intervals
   - Repeat 18" to repeat a segment at 18-second intervals

To turn off playback repeat, right-click in the viewing area, click Repeat/Shuffle, and then click Off.

Was this page helpful? Send feedback.
(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Exploring additional features
: Viewing on-screen display

Viewing on-screen display
The On-Screen Display (OSD) panel shows the video type, current playback information such as
Rewind and Forward speed, Pause, Zoom, Time Stretch Speed, and monitor type over the video
content.
It also displays the current mode in which the video is playing and the chapter and title information during
playback.
For more information about enabling on-screen display, see "Configuring General preferences."

Was this page helpful? Send feedback.
(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Using Corel FlixFinder

Corel FlixFinder is an online video search engine that lets you find and view premium video content like TV shows and movies from commercial content providers such as Netflix, Amazon and Hulu. Corel FlixFinder allows you to:

- download or stream the latest releases
- browse videos by category, compare prices and bookmark your favorites
- view detailed disc information for a movie
- submit your personal information about a movie, including your rating and comments

To access Corel FlixFinder

1. Click the FlixFinder button on the Caption bar or type the name of the movie you are looking for in the Search box.

   Corel FlixFinder Web site displays all the instances of the movie, with the price and rating displayed next to it.

2. Click the service provider of your choice to watch the online streaming and follow the on-screen instructions.

Was this page helpful? Send feedback.
(Internet connection required.)
Playing various media

Corel WinDVD is a universal media player that lets you play discs, files, folders, and streaming videos. This section contains the following topics:

- Playing optical discs
- Playing files from your computer playlist or network
- Playing folders

Was this page helpful? Send feedback.

(Internet connection required.)
Playing various media

Playing optical discs
Corel WinDVD supports the playback of a variety of media. From high-definition Blu-ray or AVCHD Discs, to DVDs, video files, audio CDs, and music files.
The application supports the following optical discs and file formats:

Supported optical discs:

<table>
<thead>
<tr>
<th>Optical Disc Types</th>
<th>File Formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blu-ray Discs/Blu-ray 3D Discs</td>
<td>BD-ROM movie disc (including BonusView, BD-Live, Blue-ray 3D support), BD-R, RE, BDXL, BDAV, BDMV</td>
</tr>
<tr>
<td>DVD</td>
<td>DVD-Video, AVCHD, AVCREC, DVD-VR, DVD+VR, Karaoke</td>
</tr>
<tr>
<td>CD</td>
<td>VCD, SVCD, Audio</td>
</tr>
</tbody>
</table>

Supported file formats

<table>
<thead>
<tr>
<th>Media</th>
<th>File format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Files</td>
<td>MPG, MPEG, AVI, DAT, VOB, H.264*, AVC, VC1*, MPEG-2 HD*, MOV, QT*, MP4, 3GP, 3GPP*, 3G2, FLV*, MKV*</td>
</tr>
<tr>
<td>Windows Media Files</td>
<td>ASF*, WMV*, WMA, DVR-MS</td>
</tr>
<tr>
<td>Audio</td>
<td>MP3*, WAV, Audio CD files</td>
</tr>
</tbody>
</table>

The file formats indicated by an asterisk may not be supported in some versions of Corel WinDVD.

Playing HD files
Corel WinDVD supports the playback of HD video files, MPEG-2 HD files (Transport, Program, and Elementary stream), WMV-HD, MP4-HD, files with 720p or 1080i resolution and also supports FLV and MKV in SD size.
In order to play these files smoothly, you must meet the recommended system requirements.

Supported Files

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corel WinDVD supports the H.264 format that is the next-generation video compression technology in the MPEG-4 standard, also known as MPEG-4 Part 10. H.264 can match the best possible MPEG-2 quality at up to half the data rate. H.264 also delivers excellent video quality.</td>
</tr>
<tr>
<td>Corel WinDVD supports the VC-1 codec that is</td>
</tr>
</tbody>
</table>
optimized for superior playback across all types of systems. Twice as fast as H.264, VC-1 is also better in decoding.

You can also use Corel WinDVD to watch QuickTime or any video files stored on your hard drive.

Note: QuickTime is installed with Corel WinDVD by default; however, some versions of Corel WinDVD do not include QuickTime, so you have to install it separately.

Windows Media Video High Definition (WMV-HD) files feature sharper and crisper images, especially intended for widescreen viewing.

Playback of HD video files may not be supported in some versions of Corel WinDVD.

To play video and audio discs

1. On the Control bar, click **Open** and click **Disc**. Browse to the drive where your disc is located.

2. To open video files recorded on a disc as data, you can use the **Open > File** option.

   This feature is only available when you are using an audio CD, DVD-Video, DVD-Karaoke, VCD or AVCHD disc or Blu-ray discs.

Was this page helpful? Send feedback.

(Internet connection required.)
Playing various media

: Playing files from your computer playlist or network

Quick links to procedures on this page:

• To open a video or audio file

Playing files from your computer playlist or network
In addition to playing video and audio discs, you can also use Corel WinDVD to play video and audio files stored on your hard drive, on an optical disc, or on a network.

To open a video or audio file
1. On the Control bar, click Open > File.
2. Browse to the drive, optical disc, or network location where the file that you want to play is stored.

Was this page helpful? Send feedback.
(Internet connection required.)
Playing folders
You can play DVD, AVCHD or BDMV folders on your computer.

To play a video folder
1. On the Control bar, click Open > Disc Folders.
2. Browse to the drive where the DVD or BDMV folder is saved.
3. Browse to the VIDEO_TS folder and click OK.

Direct from device playback
Corel WinDVD also supports direct from device playback, which allows you to play video from your digital camera without the need to download it to your computer.

To play video from a device
1. Connect your digital camera or camcorder to your computer.
2. Choose the drive of your video camera and then open the folder as you would open any other disc image folder.

Was this page helpful? Send feedback.
(Internet connection required.)
Using 3D display

Corel WinDVD supports the playback of 3D content in your Blu-ray video files and discs. The player can also simulate the 3D playback of ordinary 2D video files and DVDs.

This section contains the following topics:

• Enabling 3D mode
• Enabling Exclusive mode
• Configuring settings for 3D display

Check the Corel Web site for more information on the recommended system requirements for Blu-ray 3D playback.

If you experience any discomfort while watching 3D video, please stop playback immediately, and let the discomfort subside. It is highly recommended that you take regular breaks to relax your eyes. Please consult an ophthalmologist for proper medical attention if any feeling of discomfort persists despite the regular breaks. Before allowing young children to watch 3D videos, please consult a pediatrician or an ophthalmologist.

Was this page helpful? Send feedback.

(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Enabling 3D mode
Corel WinDVD detects the type and size of the current monitor, display card and automatically applies the necessary settings to it. The 3D mode icon located on the Control bar functions as a toggle button, which lets you switch between 2D and 3D mode. It also indicates the current 3D status.

To enable 3D mode

1. On the Control bar, click the 3D mode icon to switch to 3D mode.

   A Warning on 3D Viewing message appears. Click OK to continue.

2. The Monitor detection dialog box appears and prompts you to apply the necessary 3D settings to your monitor.

   Click Continue to apply the settings to the current monitor.

   If your computer is connected to more than one monitor, change the monitor type of the current monitor manually. For more information, see "Configuring settings for 3D display."

Was this page helpful? Send feedback.
(Internet connection required.)
Enabling Exclusive mode

If you have a NVIDIA graphic card with NVIDIA 3D Vision support on your computer or laptop, Corel WinDVD enters **Exclusive mode** automatically to play high-definition video files in 3D mode. This greatly improves the playback performance of the 3D content and offers an optimal experience.

- When you start playing HD files in 3D mode, a dialog box appears to inform you that Corel WinDVD is entering Exclusive mode. Click **Continue** to confirm or **Cancel** to watch the movie in 2D mode.

- If you open the **3D Settings** window while playing Blu-ray 3D movies in **Exclusive mode**, Corel WinDVD will exit Exclusive mode and pause the content. Turning off 3D mode, however, will play the movie without interruption, changing seamlessly from 3D to 2D.

- Corel WinDVD enters exclusive mode only when Windows Aero environment is off.

---

Copyright 2011 Corel Corporation. All rights reserved.
Using 3D display

Configuring settings for 3D display
Corel WinDVD lets you set your 3D viewing preferences during playback.

To configure 3D display settings

1. On the Control bar, click the triangle next to the 3D mode icon.

   When 3D mode is enabled, the 3D Display Status in the 3D Settings dialog box displays ON. In Content Type, choose one of the following options:
   - Auto: automatically detects 3D playback capabilities of a disc.
   - 2D: plays a movie in 2D mode.
   - 3D: plays a movie in 3D mode.

2. Enable the 2D to 3D Conversion check box to convert 2D titles to 3D on the fly. In 3D Depth adjustment, move the slider left or right to decrease or increase the depth of 3D effect.

3. In Display Type, click Display Monitor to choose the correct display panel and display configuration.
5. In Define Display, choose the correct display type and configuration:
   • Anaglyph ? plays a movie in Anaglyph format
   • NVIDIA 3D Vision ? enters Exclusive Mode and plays a movie in Frame Sequential format
   • Full HD 3D TV ? plays a movie in Checkerboard format
   • Full HD 3D TV - Interleaved ? plays a movie in Row Interleaved format
   • HDMI 1.4 Video Output ? uses frame packing technology via the HDMI 1.4 port to play your movie

   Note: The list of available options depends on your hardware configuration.

6. Enable the Set display panel size manually check box and move the slider to set the size (in inches) of your monitor/display hardware.

7. Click OK to save the settings.

Was this page helpful? Send feedback.
(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Enhancing audio and video quality

Corel WinDVD lets you customize your viewing preferences while watching your favorite videos. You can control the audio settings and functionality, select the audio source, audio technology, graphic equalizer, DSP effects, listening environment, and sound quality according to the DVD content. In addition, you can adjust the color properties, add special effects, set the display size and properties, and enable time stretch.

- All options are available while playback is in progress so you can see the effects that you have applied in real time.

- To launch the Enhancements menu, click Tools in the Control bar and click Enhancements.

This section contains the following topics:

- Setting audio device
- Setting audio effect
- Configuring karaoke settings
- Setting equalizer
- Applying video enhancements
- Adjusting video color
- Adjusting aspect ratio
- Using Time Stretch

- Some features may not be available when Use Hardware Decode Acceleration in the Preferences dialog box is selected.
- Some features may not be available for all versions of Corel WinDVD.
**Enhancing audio and video quality**

: Setting audio device

Quick links to procedures on this page:

- **To select an audio device**
- **To set up speakers**

### To select an audio device

- In the Enhancements window, click Audio.
  - On the Audio Device tab, choose one of the following output devices:
    - Headphones if you are using headphones through a headphone jack to listen to the audio output.
    - 2 speakers if you are listening to a movie on a computer which has only two speakers or a sound card that supports only two-channel audio playback.
    - 4 speakers if your computer is equipped with 4 speakers and sound cards that support four-channel audio playback.
    - 6 speakers (5.1 surround) if your computer is equipped with 5.1 speakers and sound cards that support six-channel audio playback. This option is optimal for DVD Video titles that feature multichannel encoding such as Dolby Pro-logic IIx or DTS Neo: 6.
    - 7 speakers or 8 speakers if your computer supports these configurations.
    - S/PDIF out if you are connecting your audio output to a receiver, which supports Dolby or DTS audio technology.

- Depending on the selected audio output device, different sets of options appear in the Technology drop-down menu.

### To set up speakers

<table>
<thead>
<tr>
<th>To</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust the gain for a speaker</td>
<td>Click the Adjust button located below the speaker.</td>
</tr>
<tr>
<td>Adjust the time delay for a speaker</td>
<td>Move the slider in Speaker Adjustment</td>
</tr>
<tr>
<td>Reset the gain for a speaker</td>
<td>Click the Reset button located at the bottom of the dialog box</td>
</tr>
</tbody>
</table>
To apply filtering and noise reduction technology

Specify the filtering and noise reduction technology by using the following settings.

<table>
<thead>
<tr>
<th>Technology</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo</td>
<td>Plays video or audio files in stereo sound</td>
</tr>
<tr>
<td></td>
<td>Plays crisp virtual audio through Dolby Virtual Speaker technology. Dolby</td>
</tr>
<tr>
<td></td>
<td>Virtual Speakers provides audio virtualization for two-channel speaker</td>
</tr>
<tr>
<td></td>
<td>configuration and creates realistic surround sound from those two speakers.</td>
</tr>
<tr>
<td>Room size ?</td>
<td>Choose the room size depending on what you are playing at the moment.</td>
</tr>
<tr>
<td>Dolby Pro Logic IIx ?</td>
<td>Enable the check box to expand the existing stereo or 5.1 channel audio to</td>
</tr>
<tr>
<td></td>
<td>6.1 or 7.1 channel audio playback.</td>
</tr>
<tr>
<td>Choose Movie Mode or</td>
<td>depending on what you are playing at the moment.</td>
</tr>
<tr>
<td>Music Mode,</td>
<td>Dolby Virtual Speaker provides audio virtualization for two-channel speaker</td>
</tr>
<tr>
<td>Corel Headphone</td>
<td>Optimizes your audio settings using Corel technology</td>
</tr>
<tr>
<td>Dolby Virtual Speaker</td>
<td>Provide a detailed description of each setting option and its impact on the</td>
</tr>
<tr>
<td></td>
<td>audio output.</td>
</tr>
</tbody>
</table>
configuration and creates realistic surround sound from the two speakers. Configure the following options:

- **Surround Mode**
  Choose Reference, Wide 1, or Wide 2 from the drop-down menu to specify the coverage area for the virtual speakers.

- **Dolby Pro Logic IIx**
  Enable the check box to expand the existing stereo or 5.1 channel audio to 6.1 or 7.1 channel audio playback.

In addition to the 5.1 channel Dolby II output, Dolby IIx generates back right and back left channel outputs to create a true surround sound experience. Configure the following options:

- **Choose Movie Mode or Music Mode**, depending on what you are playing at the moment.

- Click the Settings icon, and enable the Panorama feature.
check box. This feature allows you to explore the peripheral view of a movie scene in a full 360-degree form. Move the slider to adjust the Dimension and Center width.
Quick links to procedures on this page:

- To set your listening environment

## Setting audio effect

The Audio Effect tab lets you optimize the sound and adjust the karaoke settings.

### To set your listening environment

In the **Environment** area, choose a mode from the following table:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Optimized for most PC listening environments. It boosts the audio level and reduces the dynamic range for more comfortable listening.</td>
</tr>
<tr>
<td>Late Night</td>
<td>Reduces bass effects and limits peak volumes. This produces an overall softer sound with fewer startling noises.</td>
</tr>
<tr>
<td>Noisy</td>
<td>Enhances the audio range in a noisy environment.</td>
</tr>
<tr>
<td>Theater Effect</td>
<td>Experience theater-quality sound by preserving the original dynamic range of the movie.</td>
</tr>
</tbody>
</table>

- You can simulate the experience of listening to sound in a large hall or theater by choosing **Sydney theater**, **Chicago theater**, or **Broadway theater** from the drop-down menu.

---

Copyright 2011 Corel Corporation. All rights reserved.
Configuring karaoke settings
You can use Corel WinDVD to playback Karaoke DVD and VCD discs. Use these options to enhance your karaoke experience.

To configure karaoke settings

Perform one or more tasks from the following table:

<table>
<thead>
<tr>
<th>To</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate an echo/reverberation effect</td>
<td>Enable the Echo check box.</td>
</tr>
<tr>
<td>Modify the pitch so that you can find the perfect key to sing along</td>
<td>Move the Pitch slider from flat (at the left) to sharp (at the right) in half-step increments.</td>
</tr>
<tr>
<td>Select the desired audio channel for the voice and music mixing</td>
<td>Choose the following options from the Karaoke/ Multi audio drop-down menu:</td>
</tr>
<tr>
<td></td>
<td>• Stereo</td>
</tr>
<tr>
<td></td>
<td>• Dual Mono</td>
</tr>
<tr>
<td></td>
<td>• Left Mono</td>
</tr>
<tr>
<td></td>
<td>• Right Mono</td>
</tr>
<tr>
<td>Send the melody to the speakers</td>
<td>Enable the Melody check box.</td>
</tr>
</tbody>
</table>
Setting equalizer
Enhance your audio playback by selecting preset equalizer settings based on various types of sound.

To choose equalizer settings
Perform one or more tasks from the following table:

<table>
<thead>
<tr>
<th>To</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimize the sound</td>
<td>Enable the Enable Equalizer check box.</td>
</tr>
<tr>
<td>Set the equalizer presets according to</td>
<td>Choose any of the available options from the Preset</td>
</tr>
<tr>
<td>the type of audio or genre of music</td>
<td>drop-down menu.</td>
</tr>
<tr>
<td>that you are playing</td>
<td></td>
</tr>
<tr>
<td>Manually set the equalizer</td>
<td>Choose Custom and adjust the sliders to specify which</td>
</tr>
<tr>
<td></td>
<td>frequencies are increased or decreased in amplitude.</td>
</tr>
<tr>
<td>Restore the default settings</td>
<td>Click the Reset button.</td>
</tr>
</tbody>
</table>

Was this page helpful? Send feedback.
(Internet connection required.)
Applying video enhancements
You can apply filters and different effects to your video display.

To configure video enhancement settings

1. In the Enhancements window, click Video and click the Video Effect tab.
   Enable the Enable Video Upscaler check box to enhance the details in a video and produce a clearer image.
   Adjust the slider to get the desired effect.

2. In Demo Mode, choose one of the following options:
   • Normal ? lets you view the applied effects on the entire video in normal mode
   • Split ? lets you preview the applied effects in split mode. Split mode divides the screen in two halves. The left half of the screen shows the original video, while the right half shows the same video with the video enhancements applied
   • Compare ? lets you preview the applied effects on the entire video using compare mode. In compare mode, the left side contains the original video while the right side contains the same video with the video enhancements applied.

3. Enable the Enable Video Stabilizer check box to stabilize the motion from a hand-held camera
video for an improved playback performance. Choose the settings from the drop-down menu and move the slider left or right to get the desired effect. Enable the **Enable Motion Streamliner** check box to increase the frame rate of the video for a smoother motion playback.

To restore the default settings, click the **Reset** button.

Some video effects may be unavailable depending on the type of video that you are playing.
Enhancing audio and video quality

: Adjusting video color

To configure video color settings

Quick links to procedures on this page:
• To configure video color settings

Adjusting video color
Corel WinDVD color controls are similar to those on your television set. They allow you to adjust brightness, contrast, hue, and other parameters.

![Color Controls](image)

To configure video color settings

1. On the **Video** tab, select **Color**.
2. Choose your display device from the list of available options:
   • Default
   • LCD
   • CRT
   • Projector
   • Custom ? lets you create a new preset
3. Move any of the following sliders:
   • Brightness ? increases or decreases the video brightness
   • Contrast ? increases or decreases the contrast
   • Hue ? adjusts the hue from green to magenta
   • Saturation ? adjusts the vibrancy of colors in the video
   • Gamma ? corrects images designed to be viewed in one medium (for example, a movie screen) to display accurately in another screen (for example, an LCD)
To restore the default settings, click the **Reset** button.
Quick links to procedures on this page:

- To adjust the aspect ratio of the video

Adjusting aspect ratio

You can adjust the ratio of the video to resize the video display. This feature minimizes the distortion by stretching only the edges of the video and maintaining the original content at the center of the image.

To adjust the aspect ratio of the video

1. On the Ratio tab, click Fixed Aspect Ratio. Click Smart stretch to crop and stretch the sides of the video slightly, while keeping the center as it is. Choose the following options from the drop-down menu:
   - **Stretch to 4:3**? Adjusts 16:9 video content to fit the 4:3 aspect ratio. Move the Center and Width slider to find a custom stretch that fits your specific display device.
   - Stretch to 16:9 ? Adjusts 4:3 video content to fit the 16:9 aspect ratio

2. To restore the default settings, click the Reset button

Was this page helpful? Send feedback.

(Internet connection required.)
Using Time Stretch

Time stretch lets you modify the playback speed from half-speed to double-speed without losing stereo output or distorting the audio. This is a useful feature that allows you to adjust the total length or time of playback to suit your needs. If you need to finish watching a video in a time frame that is shorter than the length of the video, you can use the time-stretching feature to speed up the playback.

To configure the Time Stretch settings

- On the Time Stretch tab, click any one of the following options:
  - **Adjust playback speed** lets you control the playback speed. Move the slider to increase or decrease the playback speed of the movie that you are playing. The playback speed is displayed in the Time Info box. The remaining time displays the time left before the video ends. To ensure that the audio is not affected during playback, the maximum and minimum speed limit range from 0.5x to 2x.
  - **Set time to finish this video** lets you enter the specific time you want to finish watching the current movie clip, corresponding with the time in your computer.
  - **Adjust movie length** lets you enter the specific time available for you to complete the movie.
  - To restore the default settings, click the Reset button.
Customizing viewing preferences

You can create playlists of your audio and video titles, bookmark favorite scenes, capture screenshots or entire clips.

This section contains the following topics:

- Using playlists
- Using bookmarks
- Capturing images and clips

Was this page helpful? Send feedback.

(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Customizing viewing preferences

: Using playlists

Quick links to procedures on this page:

• To create a playlist
  To play a playlist

Using playlists
You can create custom lists of media files, group them as audio or video, and specify your preferred playback sequence. Any file type supported by Corel WinDVD can be added to the playlist, including an entire audio or video disc.
You can edit playlists by adding or removing items. You can also play an entire playlist or specific files in a playlist.

To create a playlist

1. On the Control bar, click Open > File. Browse to the folder that contains the media files that you want to include in the playlist.
2. You can also drag and drop media files to the playlist in the Playlist panel.
3. On the Playlist panel, type a name for your playlist in the Unsaved playlist text box. Press [Enter] or click outside the text box.
4. Corel WinDVD automatically saves playlists as *.cplist files in the Documents and Settings\[User Profile]\Corel\WinDVD11\Playlist folder. The default folder for playlists lets you keep sets of your favorite audio and video files handy without having to know where the files are stored.

To play a playlist

1. Right-click in the viewing area and click Go to Playlist.
2. Click a playlist.

You can also perform the following tasks:

To

Do the following

Create a temporary playlist
Drag and drop files into the viewing area. To delete the list, click the Delete Playlist button at the bottom of the playlist panel.
Add or remove a file in a playlist
Click a file and click the Add or Remove button at the bottom of the Playlist panel.
You can play a specific file in a playlist by double-clicking the file.
## Using bookmarks

Bookmarks let you mark your favorite scenes in a movie for future access. You can add bookmarks when playing DVD-Video, DVD+VR, and DVD-VR, export a bookmark to a default folder on the hard drive and open existing bookmarks from movies.

### To create bookmarks

1. While playing a video file, click Tools > Bookmarks. The Bookmark tray appears.
2. When you get to the scene you want to bookmark, click the Add Bookmark button. By default, the bookmark is displayed as a thumbnail image on the Bookmark tray.
   - By default, Corel WinDVD automatically saves bookmarks as *.XML files in the Documents and Settings\[User Profile\]AppData\Roaming\Corel\WinDVD11\bookmark folder. A bookmark file is saved in the following format ?Title ID_Chapter ID HH:MM:SS.?.

### To go to a bookmark

- Double-click the bookmark thumbnail on the Bookmark tray.

### To export bookmarks

- In the Bookmark tray, click the Export button.

### To import bookmarks

- In the Bookmark tray, click the Import button.

### To delete bookmarks

1. In the Bookmark tray, click a bookmark thumbnail, and click the Delete button.

---

**Was this page helpful? Send feedback.**  
(Internet connection required.)

---

Copyright 2011 Corel Corporation. All rights reserved.
Capturing images and clips
Corel WinDVD lets you capture still images and video clips (called Quick Clips) when you play DVD and video files.
Capture your perfect movie scene and use it on your computer as a desktop wallpaper by using this feature. You can also create an animated image from a selected movie clip segment.

To capture still images
1. While playing a video file, click Tools > Capture. The Capture tray appears.
2. Click the Capture button to capture the current frame.
   • The image files are saved as *.BMP files in the Documents and Settings\[User Profile]\AppData\Roaming\Corel\WinDVD11\capture folder.
   • By default, the captured image is displayed as a thumbnail image in the Capture tray. To delete a thumbnail image, click the thumbnail in the Capture tray, and click the Delete button. Note that only the thumbnail is deleted and the graphic/video file remains in the Capture folder until deleted manually.

To capture video clips
1. While playing a video file, click Tools > Capture. The Capture tray appears.
2. When you get to the part of the video that you want to capture, click the Record button. The captured clips are displayed as thumbnail images in the Capture tray.
   • The captured clips are saved as *.GIF files in the Documents and Settings\[User Profile]\AppData\Roaming\Corel\WinDVD11\Capture folder.
   • To see a larger preview of a thumbnail,
double-click on the thumbnail.

To send a Quick Clip video by email

• In the **Capture tray**, click the Share by email button.

  Corel WinDVD generates the attachment and then launches the default email program.

To configure Quick Clip settings

1. Click the Preferences button on the Caption bar.
   On the Playback Control tab, set your preferred options in Quick Clip Setting and click Apply.

Was this page helpful? Send feedback.
(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Configuring Corel WinDVD

You can configure some advanced Corel WinDVD settings based on your preferences. For example, you can specify the storage location of the media files on your computer, add or remove plug-ins, set privacy and security options, or select the sound quality of the audio files that you play from CDs or DVDs.

Some features may not be available in all versions of Corel WinDVD. For more details, visit the Corel Web site www.corel.com.

This section contains the following topics:

- Accessing preferences
- Configuring General preferences
- Configuring Playback Control
- Configuring Audio/Video
- Configuring Region settings
- Configuring Power settings
- Viewing Information

Was this page helpful? Send feedback.

(Internet connection required.)
Configuring Corel WinDVD

: Accessing preferences

Quick links to procedures on this page:

• To access preferences

Accessing preferences
You can configure the settings for Corel WinDVD to suit your specific requirements.

To access preferences

• Do one of the following:

  • Click the Preferences button on the Caption bar.
  • Right-click in the viewing area and choose Preferences.
  • Press [Ctrl] + [.] to open Preferences.

Was this page helpful? Send feedback.
(Internet connection required.)
Configuring Corel WinDVD

: Configuring General preferences

Quick links to procedures on this page:

• To configure general preferences

Configuring General preferences
You can configure general properties in the General tab.

To configure general preferences

1. In the Corel WinDVD Preferences dialog box, click the General tab.

2. In the Resume Settings drop-down menu, choose one of the following options:
   • Always start from beginning? playback always resumes from the start of the disc
   • Always start from the last position? playback always resumes from the point where the disc was stopped

3. In the Player Settings area, enable any of the following options:
   • Start from full screen mode? launches DVD in full screen mode
   • Always on top? opens the application window on top of other open applications
   • Enable on-screen display? displays control panels and other information on screen
   • Enable Mouse Simulation in BD-J Menus? activates mouse functionality in BD-J menus

4. In the Settings area, enable the Hide control panel automatically in check box and type a number to set the number of seconds of inactivity to allow before hiding any controls that are displayed in the viewing window.

5. In the Disc Settings, click the drop-down menus to change the following settings:
   • Menu Language? specifies the language for menu text
   • Audio Language? specifies the language for audio
   • Subtitle Language? specifies the default language for movie subtitles
   • Subtitle/CC Style? specifies how subtitles look when they display on screen

Was this page helpful? Send feedback.
(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Configuring Playback Control

The application lets you set controls during playback and capture. You can set Parental Control to prevent children and minors from viewing movies that do not meet the rating guidelines you choose. LanguageMate, a feature that lets you take advantage of learning a new language through repetition, can also be set.

To configure playback controls

1. In the Corel WinDVD Preferences dialog box, click the **Playback Control** tab.

   Perform a task from the following table:

<table>
<thead>
<tr>
<th>To</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the folder where you want to store bookmarked/captured images and movie clips</td>
<td>In the Capture/Bookmark Directory area, choose a folder.</td>
</tr>
<tr>
<td>Set the speed of instant replay playback</td>
<td>In the Control Timing Configuration area, set the Instant Replay Time in seconds. The default speed is 5 seconds.</td>
</tr>
<tr>
<td>Set the speed of instant advance playback</td>
<td>In the Control Timing Configuration area, set the Skip Forward time in seconds. The default speed is 30 seconds</td>
</tr>
</tbody>
</table>

2. Set the parental control restrictions for playing a DVD that is above the rating limit

   In the Parental Playback Control area, click Set Password.

   Set the maximum rating allowed for viewing movies in Corel WinDVD

   In the Parental Playback Control area, click Set Rating.

   Set the image size for captured clips

   In the Quick Clip Setting area, choose the default image size from the Capture Size drop-down menu.

   Adjust the time period

   In the Quick Clip
between each captured frame of a clip

Set the default playback speed of a clip

Use the LanguageMate feature

Setting area, set the Interval by moving the slider.

In the Quick Clip Setting area, adjust the Play Speed slider.

In the Language Mate area, enable the Enable check box.
Configuring Audio/Video
You can set audio preferences, such as output, speaker configuration and subwoofer control, and adjust the video settings.

**To configure the audio and video settings**

1. In the Corel WinDVD Preferences dialog box, click the Audio/Video tab. Perform a task from the following table:

<table>
<thead>
<tr>
<th>To</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure audio</td>
<td>In the Advanced Audio Control area, enable the following check boxes:</td>
</tr>
<tr>
<td>settings</td>
<td>Send 0.1 (LFE Subwoofer) to Speakers/Headphones ?</td>
</tr>
<tr>
<td></td>
<td>sends the subwoofer signal to the main speakers or headphones</td>
</tr>
<tr>
<td></td>
<td>• Remember Volume Setting ? retains the last volume level setting</td>
</tr>
</tbody>
</table>

2. Configure audio settings

- •
for the next time you run the application Enable Auxiliary Audio? mixes the output of auxiliary audio devices with your MIDI and waveform-audio output devices

•

Enter 3D mode automatically

In the 3D Display area, enable the Always use 3D Mode for 3D media check box

In the Advanced Video Control area, enable the following options:

• Use Hardware Decode Acceleration - Inter Clear Video? shows the corresponding video technology (NVIDIA PureVideo HD, AMD Radeon, NVIDIA 3D Vision technology or Intel Clear Video)

• PAL TruSpeed? automatically corrects PAL speed errors and

Configure video settings
In the **Deinterlace** drop-down menu, select a deinterlacing method.

Deinterlace video

Allow the application to access Blu-ray playback compatibility for the Windows 7 Aero environment

Enable the Allow WinDVD to check if Blu-ray is supported in the Windows Aero environment (Windows 7 only) check box.
Configuring Region settings

Corel WinDVD allows you to change the region settings of your optical drive to match the region requirements of your discs.

Determine the region for which a DVD is designed by looking for a small standardized globe icon in the middle of the disc which indicates the region number. If the disc can be played in more than one region, it will have more than one number on the globe icon. If the disc does not have any regional coding, ?ALL? is printed over the globe icon or there is no globe icon at all.

To change your DVD drive region settings

1. In the Corel WinDVD Preferences dialog box, click the Region tab.

   Note: Corel WinDVD supports only encrypted, regionalized discs. The available region settings are limited to the supported features for the current disc.

2. Select a media type from the drop-down menu, and then choose a region.

   You can change the region settings of your optical drive only five times. Once you reach the limit, you can no longer make any changes. The changes until permanent box displays the number of changes left.
Configuring Power settings

With the optimized power saving options, memory caching and battery end life control, you can enjoy your movies without worrying that your battery may die unexpectedly. The power-saving feature of Corel WinDVD applies only to laptop computers running in battery mode.

To configure the power-saving settings

1. In the Corel WinDVD Preferences dialog box, click the Power tab.
   Perform a task from the following table:

<table>
<thead>
<tr>
<th>To</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize battery life while running Corel</td>
<td>In the Mobile Power Scheme area, enable the Enable WinDVD Mobile Power Scheme</td>
</tr>
<tr>
<td>WinDVD on your laptop</td>
<td>check box.</td>
</tr>
<tr>
<td>View and customize the power scheme options</td>
<td>In the Mobile Power Scheme area, click View Mobile Power Settings.</td>
</tr>
<tr>
<td>Enable the system memory optimizations to</td>
<td>In the Mobile Power Optimizations area, enable the Enable Mobile Power Optimizations check box.</td>
</tr>
<tr>
<td>reduce power</td>
<td>In the Mobile Power Optimizations area, choose the following power-saving</td>
</tr>
<tr>
<td></td>
<td>modes from the System Memory Usage drop-down menu.</td>
</tr>
<tr>
<td></td>
<td><strong>Aggressive</strong> lets you achieve the best power-saving effect, but may affect</td>
</tr>
<tr>
<td></td>
<td>the performance of other applications running at the same time.</td>
</tr>
</tbody>
</table>

2. Choose a power-saving mode

   •
Average ? lets you achieve some power-saving effect, but does not significantly affect other applications. **Conservative ?** lets you achieve the least power-saving effect, but provides maximum flexibility to run new applications.

Set the minimum battery run time.

In the Minimum Battery to Play area, move the lever from left to right to set the percentage (3%-25%). Note: This setting prevents your laptop from unexpectedly shutting down during movie playback. When the battery life reaches the level indicated, Corel WinDVD will stop playback automatically; however, you will still be able to run other applications on your laptop.

View the battery status of your laptop

Check the Battery Information area. The Power Source area displays the current power supply that your laptop is using. If the power supply is battery, the application displays the remaining battery power in the Estimated battery life time area.

---

**Was this page helpful? Send feedback.**
(Internet connection required.)
Viewing Information

The Information tab displays the detailed information about the current system settings. You can use this information when troubleshooting or requesting technical support.

To view information

In the Corel WinDVD Preferences dialog box, click the Information tab.
Using Blu-ray Disc technology

Corel WinDVD supports various Blu-ray Disc (BD) features and allows you to get the most out of the BD technology.

This section contains the following topics:

- Enabling the BD pop-up menu
- Connecting through BD-Live?
- Accessing BD-J content
- Digital audio output for BD-ROM
- Audio mixing for BD-ROM discs
- Audio setup

Check the Corel Web site for more information on the recommended system requirements for Blu-ray playback.

Was this page helpful? Send feedback.

(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Enabling the BD pop-up menu
Corel WinDVD lets you control BD playback. You can browse through a multipage menu, select different menu paths, or enable and disable pop-up menu button sounds.
To enable the BD pop-up menu:

• On the Control bar, click the Disc menu button.

• The Disc menu is enabled during playback of BD discs with BDMV or BD-J contents and is disabled during playback of BD discs with non BD-J content.
Using Blu-ray Disc technology
: Connecting through BD-Live

Connecting through BD-Live
Corel WinDVD allows you to easily connect to the Internet and download special features, movie trailers, and access additional information about your BD title in real time by using the BD-Live function.

A Blu-ray disc with BD-Live functionality and a BD player with an Internet connection are needed to enable this function. The features accessible through BD-Live depend on the BD title you have.

Was this page helpful? Send feedback.
(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Accessing BD-J content
You can enable and access BD-J content depending on the features that the BD title supports. Most keyboard shortcuts are not operational while accessing BD-J content. You can use mouse simulation to navigate and control the BD-J operation by enabling mouse simulation in Preferences.
Quick links to procedures on this page:

- To enable or disable Bypass mode

Digital audio output for BD-ROM
This section explains the S/PDIF and HDMI digital audio output behavior for BD-ROM discs.

Synchronization with Vista device playback settings
Corel WinDVD syncs with the audio playback device setting of the Windows Vista and Windows 7 operating systems.

- When you change the Windows Vista and Windows 7 audio settings, the Corel WinDVD audio settings are adjusted accordingly.

Bypass and non-bypass modes
You can have Corel WinDVD bypass the audio stream (also known as Bypass mode). The actual results depend on the capability of the external decoder. In Non-bypass mode, Corel WinDVD decodes the audio stream and the actual result depends on the features enabled in the application.

To enable or disable Bypass mode

- On the Supported Formats tab of the Digital Output Device Properties window, enable or disable the Dolby Digital check box.

Was this page helpful? Send feedback.
(Internet connection required.)

Copyright 2011 Corel Corporation. All rights reserved.
Audio mixing for BD-ROM discs
This exclusive setting for BD-ROM discs lets you enable audio mixing in primary and secondary audio and sound effects before sending the audio stream to a Digital Audio Output device.
Audio setup

The option in Advanced Audio Settings is available only if the system is equipped with S/PDIF or HDMI port. The setting works only when Bypass mode is enabled during digital audio out. Once the option is enabled, Corel WinDVD outputs primary audio when producing digital output. If the option is disabled, Corel WinDVD enables the mixer and produces mixed audio.

- This option is enabled by default in BD-ROM discs.
## Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Ctrl] + [A]</td>
<td>Audio track selection</td>
</tr>
<tr>
<td>[Ctrl] + [E]</td>
<td>Eject</td>
</tr>
<tr>
<td>Right</td>
<td>Forward</td>
</tr>
<tr>
<td>Left</td>
<td>Rewind</td>
</tr>
<tr>
<td>F</td>
<td>Full Screen/Windows Mode</td>
</tr>
<tr>
<td>G</td>
<td>Camera Angle selection</td>
</tr>
<tr>
<td>K</td>
<td>Bookmark</td>
</tr>
<tr>
<td>L</td>
<td>Now Playing/Playlist</td>
</tr>
<tr>
<td>M</td>
<td>Mute/Restore sound</td>
</tr>
<tr>
<td>[Ctrl] + [M]</td>
<td>Main menu</td>
</tr>
<tr>
<td>[Ctrl] + [O]</td>
<td>Open</td>
</tr>
<tr>
<td>[Ctrl] + [Shift] + [M]</td>
<td>Pop-up menu (for Blu-ray)</td>
</tr>
<tr>
<td>Ctrl + [ ]</td>
<td>Instant replay</td>
</tr>
<tr>
<td>Ctrl + ]</td>
<td>Skip forward</td>
</tr>
<tr>
<td>R</td>
<td>Resume</td>
</tr>
<tr>
<td>S</td>
<td>Subtitle selection</td>
</tr>
<tr>
<td>C</td>
<td>Capture</td>
</tr>
<tr>
<td>D</td>
<td>Switch to 2D / 3D Mode</td>
</tr>
<tr>
<td>[Ctrl] + [D]</td>
<td>3D Settings</td>
</tr>
<tr>
<td>[Ctrl] + [,]</td>
<td>Preferences</td>
</tr>
<tr>
<td>Tab</td>
<td>Show Info</td>
</tr>
<tr>
<td>T</td>
<td>Title selection</td>
</tr>
<tr>
<td>[Ctrl] + [X]</td>
<td>Exit</td>
</tr>
<tr>
<td>+</td>
<td>Zoom in</td>
</tr>
<tr>
<td>-</td>
<td>Zoom out</td>
</tr>
<tr>
<td>Esc</td>
<td>Window Mode selection</td>
</tr>
<tr>
<td>F1</td>
<td>Help</td>
</tr>
<tr>
<td>[Shift] + [+]</td>
<td>Increase brightness</td>
</tr>
<tr>
<td>[Shift] + [-]</td>
<td>Decrease brightness</td>
</tr>
<tr>
<td>[Shift] + [Down]/Wheel Down</td>
<td>Decrease volume</td>
</tr>
</tbody>
</table>
[Shift] + [Up]/Wheel Up  Increase volume
←                      Move left
→                      Move right
↑                      Move up
↓                      Move down
Page Down               Next chapter
Page Up                 Previous chapter
Space                   Play/Pause
Enter                   Run
End                     Stop
[Ctrl] + Right          Next frame
1-0                     Go to chapter N
F2                      Red color key (for Blu-ray)
F3                      Green color key (for Blu-ray)
F4                      Yellow color key (for Blu-ray)
F5                      Blue color key (for Blu-ray)